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What is OOG?
OOG, The Object Orientation Game is a Windows application that lets you play with and attempt to solve 
various types of polyform puzzles.    Follow this link to learn how to play OOG.

Key Features
Here is a quick list of some of the major features of OOG and links to their descriptions.

· Multiple polyform puzzle games in a single application
· Automatically determines when you've found any solution to a puzzle
· Automatic snapping, or alignment, of game pieces to the puzzle and each other
· Create your own puzzles that can be saved to disk and exchanged with others
· Save your progress on a puzzle so you can try again later
· All game play operations are performed using a two or three button mouse
· Player progress tracking remembers which puzzles you've solved for each polyform
· Animated hints and solving of puzzles for the frustrated (even for those you create yourself)
· Ability to change the color of the game pieces and the puzzle for each polyform
· Auto-Advance, By Number and By Picture puzzle selection methods
· A complete Windows Help file describing game play and all features (you're reading it!)

OOG is built "on top of" the Object Orientation Game Library, OOGL.    This very powerful library is the 
real brains behind OOG and allows us to present you with many different types of polyform puzzles in a 
single application.    MCM Productions developed OOG and OOGL using the latest object-orientated 
analysis, design and programming techniques, more commonly abbreviated as OOA, OOD and OOP by 
the software community.    (Everybody see our little joke?)

MCM Productions hopes you enjoy playing OOG. We enjoyed developing it for you!



What are polyform puzzles?
The goal of a polyform puzzle is rather simple to understand.    (It is usually the solution that causes all 
the problems.)    Your goal is to arrange a given set of shapes to completely overlay, or cover, a given 
puzzle outline.    The resulting solution must not and will not contain any overlap amongst the shapes.    
Note that many polyform puzzles have more than one solution.

While the premise behind polyform puzzles may sound rather simple, finding the solutions can be very 
challenging...and frustrating.

The shapes, or game pieces, for a given polyform puzzle all have something in common.    Each game 
piece is composed of one or more copies of a base shape or shapes.    For instance, each game piece 
found in the Pentominoes polyform consists of a different combination of 5 equally sized squares.    So the
base shape for pentominoes is the square.    It is also possible for a polyform to have more than one base 
shape.    For example, a polyform could have a square and a right triangle as it's base shapes.    All the 
polyforms in OOG consist of a single base shape.    But keep your eyes open for future releases.

This version of OOG contains the following popular polyforms:

Tangrams
Pentominoes
Hexagons
Polyominoes

Follow this link to learn how to play OOG.



The Tangrams Polyform
Tangrams is an ancient Chinese puzzle consisting of the 7 game pieces shown below.

The base shape for Tangrams is an isosceles right triangle.    The two smallest triangles are an example 
of the Tangrams base shape.    All of the remaining shapes are formed by combining multiple copies of the
base shape.    The medium sized triangle, the square and the parallelogram are each composed of two of 
these small triangles.    The large triangle is formed by combining two medium sized triangles or four small
triangles.

The Tangrams polyform can be played via a selection on the Switch Menu.

Click here for a description of the polyform puzzles found in OOG.

Follow this link to learn how to play OOG.



The Pentominoes Polyform
Pentominoes is a very complex polyform consisting of the 12 game pieces shown below.

The base shape for Pentominoes is a square and the game pieces represent the 12 unique combinations 
for arranging a group of 5 equally sized squares edge to edge without duplication.

The Pentominoes polyform can be played via a selection on the Switch Menu.

Click here for a description of the polyform puzzles found in OOG.

Follow this link to learn how to play OOG.



The Hexagons Polyform
Hexagons is a very complex polyform consisting of the 10 game pieces shown below.

The base shape for Hexagons is, oddly enough, a hexagon.    There are 3 game pieces consisting of 3 
equally sized hexagons and 7 game pieces consisting of 4 equally sized hexagons.

The Hexagons polyform can be played via a selection on the Switch Menu.

Click here for a description of the polyform puzzles found in OOG.

Follow this link to learn how to play OOG.



The Polyominoes Polyform
Polyominoes is a very complex polyform consisting of the 12 game pieces shown below.

The base shape for Polyominoes is a square.    Each game piece is formed by combining multiple equally 
sized squares edge to edge.    The smallest game pieces consist of 4 equally sized squares while the 
largest is formed using 7 squares.

The Polyominoes polyform can be played via a selection on the Switch Menu.

Note that this polyform puzzle is only available to registered users of OOG.

Click here for a description of the polyform puzzles found in OOG.

Follow this link to learn how to play OOG.



How to play OOG
Inorder to solve the polyform puzzles presented by OOG, you must be able to manipulate the given set of 
shapes, or game pieces.    There are only three operations necessary for performing this task and all are 
performed using either a two or three button mouse.    (These are the exact same operations you will use 
when you create your own puzzles.)

For each of the shape operations listed below, the cursor must be inside the shape you wish to 
manipulate prior to starting the selected operation.    A detailed step-by-step explanation of each of these 
operations is given below.

Shape Operation Mouse Operation
Move a shape Left Button Click + Drag
Rotate a shape Right Button Click + Drag
Flip (or mirror) a shape * Left+Right Button Click

*This operation can also be performed using the middle button of a three button mouse.

Upon completion of any of these operations, OOG makes a decision about where you were attempting to 
place the shape and automatically snaps the shape to its closest neighbor.    Once snapping is complete, 
OOG checks to see if the puzzle has been solved.    If the puzzle has been solved...well, you'll see.

Follow this link for more information about the solving of puzzles.

Follow this link if you're interested in hearing more about the OOG snapping algorithm.

Moving a Shape
Perform the following steps when you wish to move one of the game pieces:

· place the mouse cursor over the shape you wish to move
· press and hold the left mouse button
· the shape will change to an outline
· drag the shape outline to the desired location
· release the left mouse button
· the shape will change back to being fillled-in

Rotating a Shape
Perform the following steps when you wish to rotate one of the game pieces:

· place the mouse cursor over the shape you wish to rotate
· press and hold the right button
· the shape will change to an outline
· the point of rotation will be highlighted by a small circle on the shape
· the cursor will change shape to indicate how the mouse should be moved
· move the mouse in a circle about the point of rotation on the shape
· notice how the cursor changes shape as you rotate to help guide you along
· release the right mouse button
· the shape will change back to being filled-in

Flipping a Shape
Perform the following steps when you wish to flip a game piece on its back:

· place the mouse cursor over the shape you wish to flip
· press and then release both the left and right mouse buttons, or



· press and then release the middle button of a three button mouse

Flipping performs differently depending on which shape is being flipped.    There is no easy way to 
describe how shapes are flipped that would explain all possible cases.    We recommend you experiment 
with each shape in a given polyform.    It is important to note that not all shapes can be flipped as the 
flipping of some shapes in no way changes their orientation on the screen (i.e. the square in Tangrams).



Some notes about solving puzzles
The goal of a polyform puzzle is to arrange the given set of shapes to completely overlay, or cover, the 
displayed puzzle outline.    The resulting solution must not and will not contain any overlap amongst the 
shapes.    The majority of the puzzles found in OOG have more than one possible solution.    OOG 
automatically detects whenever you solve the current puzzle no matter which solution you happen to find. 
You are even free to solve the current puzzle anywhere on the playing field.    You do not have to align the
game pieces with the puzzle outline inorder for OOG to detect that you have solved the puzzle.    Even if 
you create your own puzzles and give them to a friend, OOG will automatically detect their solutions to 
your puzzle no matter which one they find.    Even if it has more than one solution and you didn't even 
know it.

If you find yourself frustrated while trying to solve a particular puzzle, you can always save your current 
layout to disk and take a break.    Then at a later time, you can restore your work and try again.    If you get
really frustrated, you can always ask for a hint or ask to see the solution.

Once you have solved a puzzle, OOG will perform the "game over" fanfare according to the settings in the
Game Setup Dialog Box and then update your player progress tracking data.    You will then be presented 
with one of the two message boxes discussed below.

After Solving a Built-In Puzzle
After solving one of the puzzles built into OOG, you are presented with a dialog box with 3 push buttons.   
Select the first button to advance to the next puzzle in the sequence.    The second button allows you to 
gaze at your solution.    Choose the third button if you would like to save your solution to disk using the 
save layout feature.

After Solving a Puzzle Loaded from Disk
After solving a puzzle that you have loaded from disk, you are presented with a dialog box with 3 push 
buttons.    Select the first button if want to load another puzzle from disk.    The second button allows you 
to gaze at your solution.    Choose the third button if you would like to save your solution to disk using the 
save layout feature.



What is player progress tracking?
The player progress tracking feature gives OOG the ability to remember which puzzles a player has 
solved for a particular polyform.    Whenever you play, a database is being maintained that is used to store
which puzzles have been solved for the current polyform.    When you solve a puzzle, the database is 
updated to identify that that particular puzzle has been solved.    This is something OOG does 
automatically.    You can not turn this feature off.    However, you can decide whether the player progress 
database is maintained for just the current game session or whether it is saved to disk where it can then 
be restored the next time you play.    You can configure this option using the New Player Dialog Box.

Note that the player progress tracking feature only stores the "solved status" information about the 
puzzles built into OOG.    It does not maintain any information for the puzzles you create and then load in 
from disk.

The solved puzzle data in the player progress database is also used by the following OOG features.    
Follow these links for further information.

Advance to the Next Puzzle
Select a Puzzle By Number
Select a Puzzle By Picture



The OOG Snapping Algorithm
Snapping is the catch phrase used to describe the operation performed by the OOG auto-shape 
alignment algorithm.    The snapping algorithm is invoked at the conclusion of every shape maneuver 
operation (i.e. move, rotate or flip) and its purpose is to "guess" at the intended location of the shape 
relative to its neighboring shapes and/or the puzzle outline.    Once the algorithm has made its decision, it 
snaps the shape to the selected location thereby freeing the player from having to worry about perfectly 
aligning the game pieces along side each other.

Why Should I Care About The OOG Snapping Algorithm?
You do not need to understand anything about this algorithm inorder to enjoy solving and creating 
polyform puzzles with OOG.    It is expected that the majority of users will not need to concern themselves
with this topic at all.    The only time you might be interested in the operation of the snapping algorithm is 
when you are creating your own polyform puzzles.    When you are creating puzzles, there are menu 
items available that allow you to change the behavior of this algorithm.    (More on this below.)

How Does Snapping Work?
As you will notice from the examples given below, the snapping algorithm deals only with the positional 
alignment of the game pieces.    It will only translate, or move, a game piece in the horizontal and/or 
vertical direction when performing a snap.    It does not do any rotational alignment of the shapes.    The 
snapping algorithm is capable of performing any one of the following types of snaps.

Snapping a point to another point (P2P)
Snapping a point to a line (P2L)
Snapping a line to a point (L2P)

The type of snap performed after a shape has been manipulated depends on whether you are solving or 
creating puzzles.    P2P snapping is the only type of snapping performed by the algorithm when you are 
solving puzzles.    You can not turn this on and off.    It is always there, always being done.    It is the only 
type of snapping you'll need when solving puzzles, don't worry about the other two.    However when you 
are creating puzzles, the algorithm can be configured, at any time, to perform any and only one of the 
snap types listed: P2P, P2L or L2P.    You can select which type of snap is performed by the algorithm by 
accessing the OOG Quick-Click Menu.    This menu is accessed by clicking the right mouse button on the 
window background.    Simply select the type of snapping you want and the algorithm continues in that 
manner until you make another selection.

Snapping Examples
To hopefully give you a better explanation of the different types of snapping, we present the following 
examples.    For all of the examples, shape A is the active shape that has just been moved, flipped or 
rotated and is about to be snapped by the algorithm to shape B.

Point to Point - Example #1
Notice how the corners, or points, of triangle A have been snapped to the corners of triangle B.



Before the Snap After the Snap

Point to Point - Example #2
Notice how the corners, or points, of square A have been snapped to puzzle outline B.

Before the Snap After the Snap

Point to Line Example
Notice how the point forming the right angle in triangle A has been snapped to the left-mose edge, or line 
segment, of square B.    We say the "point has been snapped to the line".

Before the Snap After the Snap

Line to Point Example
Notice how the bottom-most edge, or line segment, of square A has been snapped to the point forming 
the right angle in triangle B.    We say the "line has been snapped to the point".



Before the Snap After the Snap



The Menu Commands
The following menus are available while playing OOG.

The Puzzle Menu              Selecting puzzles, save/restore progress, create/load a puzzle...
The Options Menu             Configure game operations, change colors, change players...
The Switch Menu              Switch to the polyform puzzle of your choice
The Help Menu                  Complete access to the application help system

Following this link to see the menu commands available while creating your own puzzles.



The Puzzle Menu
The following commands are available from the Puzzle menu.

Next                                                 Advance to the next puzzle in the sequence
By Number...                     Choose a puzzle based on its assigned number
By Picture...                       Select a puzzle from a grid of picture buttons
Restart Puzzle                   Reset the game pieces to their starting locations
Save Layout...                   Save the current layout of your game pieces
Restore Layout...               Restore a previously saved layout of your game pieces
Create Puzzle...                 Create your own puzzle and save it to disk
Load Puzzle...                   Load a previously created puzzle from disk
Exit                                                  Leave the application



Advancing to the next puzzle
Selection of this menu item advances you to the next puzzle in the current polyform.    If you are currently 
at the last puzzle in the sequence, you will be wrapped back to the first puzzle.    This menu item is also 
available via the 'F2' function key during game play.

The following are the two other puzzle selection methods available in OOG.

Selecting a puzzle by it's number
Selecting a puzzle by it's picture



Selecting a puzzle by it's number
Selection of this menu item allows you to choose a puzzle based solely on its assigned puzzle number.    
Each puzzle in OOG is assigned a unique number for its assigned polyform.    The puzzle numbering 
system starts with number #1 and increases up to the maximum number of puzzles for that polyform.    
The By Number Dialog Box allows you to select a puzzle via its assigned number.    The following 
paragraphs describe the components of the dialog box.

Puzzle # Text
This text string is located directly above the scroll bar and identifies the current puzzle number selected 
by the scroll bar as well as whether or not that puzzle has been solved.    OOG determines whether or not 
the puzzle has been solved by accessing the player progress database that is being maintained by the 
player progress tracking feature.

Puzzle # Scroll Bar
The scroll bar is used to select which puzzle number is to be loaded.    The text string above the scroll bar 
identifies the current scroll bar position and the "solved status" of that puzzle.

Command Buttons
Click the OK button to have OOG load the puzzle corresponding to the number indicated by the scroll bar 
position and associated text.    Click the Cancel button if you wish to void your selection and return to the 
original puzzle you were playing.    Clicking the Help button will display this help page.

The following are the two other puzzle selection methods available in OOG.

Advancing to the next puzzle
Selecting a puzzle by it's picture



Selecting a puzzle by it's picture
Selection of this menu item allows you to choose a puzzle from an array of pictures via the By Picture 
Dialog Box.    The following paragraphs describe the components of this dialog box.

Button Grid
The majority of the display area of this dialog box is composed of the grid of puzzle buttons.    The grid 
has 3 rows of 4 buttons each for a total of 12 puzzle buttons.    Each button displays a picture of a different
polyform puzzle with the assigned number for that puzzle displayed in the top, left corner of the button.    
You select the puzzle of your choice, by clicking the appropriate button.    Any puzzle marked as solved in 
the current player progress database, has the text *solved* written across the bottom of the button.    
(Unsolved puzzles contain the text unsolved.)    The player progress database is maintained by the 
player progess tracking feature of OOG.

Command Buttons
The Next and Prev buttons are used to sequence through the pages of puzzle buttons for the current 
polyform.    These buttons allow you to wrap around the sequence at either end.    For example if puzzle 
#1 is currently being displayed as the top, left button in the grid and you select the Prev button, the dialog 
box will sequence to the last page of buttons for the current polyform.
Click the Cancel button if you wish to exit the dialog box and return to your previous puzzle.    The Help 
button will display this help page.

The following are the two other puzzle selection methods available in OOG.

Advancing to the next puzzle
Selecting a puzzle by it's number



Restarting a puzzle from scratch
Selection of this menu item allows you to restart the current puzzle by resetting all the game pieces back 
to their original positions. This menu item is also available via the 'F3' function key.



Saving your progress on a puzzle
This feature allows you to save the current layout of your game pieces to disk.    The layout can then be 
restored at a later time so you can pick up right where you left off on a puzzle.    The save and restore 
functions are available from the menu system both when you are solving and when you are creating 
polyform puzzles with OOG.

Upon selection of this menu item you will be presented with the Save Layout Dialog Box.    This is just a 
standard File Save Dialog Box.    The dialog box's File Name edit control will contain one of the following 
suggested file names:

1) XXX_###.SAV when solving puzzles
2) XXX_PUZ.SAV when creating puzzles

The .SAV file extension indicates you are saving a puzzle layout.    The ### will contain the puzzle 
number for the current puzzle you are solving and will always contain three digits.    If the puzzle number 
requires less than three digits it will have leading zeroes.    The XXX characters are references to which 
polyform puzzle you are currently working with as shown below.    If you are solving a puzzle that you 
have loaded from disk, the suggested file name will be the name of the loaded puzzle file with the .SAV 
file extension.

Polyform File Name Characters
Tangrams TAN
Pentominoes PNT
Hexagons HEX
Polyominoes PLY

Command Buttons
Once you've selected the desired destination directory and file name for storing the saved layout, click the
OK button to write the puzzle layout data to disk.    Click the Cancel button if you decide you no longer 
wish to save your current layout.    Clicking the Help button will display this help page.

Follow this link for information about how to restore your puzzle layouts.



Restoring your progess on a puzzle
This feature allows you to restore a previously saved layout of your game pieces from disk.    The save 
and restore functions are available from the menu system both when you are solving and when you are 
creating polyform puzzles with OOG.

Upon selection of this menu item you will be presented with the Restore Layout Dialog Box.    This is just a
standard File Open Dialog Box.    The dialog box's File Name edit control will contain one of the following 
suggested file names:

1) XXX_###.SAV when solving puzles
2) XXX_*.SAV when creating puzles

The .SAV file extension indicates you are restoring a previously saved puzzle layout.    The ### will 
contain the puzzle number for the current puzzle you are solving and will always contain three digits.    If 
the puzzle number requires less than three digits it will have leading zeroes.    The XXX characters are 
references to which polyform puzzle you are currently working with as shown below.    If you are solving a 
puzzle that you have loaded from disk, the suggested file name will be the name of the loaded puzzle file 
with the .SAV file extension.

Polyform File Name Characters
Tangrams TAN
Pentominoes PNT
Hexagons HEX
Polyominoes PLY

Command Buttons
Once you've selected the desired source directory and file name for the layout you wish to restore, click 
the OK button.    Click the Cancel button if you decide you no longer wish to restore a layout from disk.    
Clicking the Help button will display this help page.

Potential Pitfalls
This operation will reject any file it does not recognize as being an OOG layout file.    If you attempt to load
"any old file" using this command, it will be rejected.    You can not load a created puzzle file using this 
operation.    The file will be rejected.    You can only load layout files saved for the current polyform puzzle. 
For instance if you try to restore a Pentominoes layout while playing Tangrams, if will be rejected.    First 
switch to Pentominoes and then restore the layout using this operation.    You have been warned.

Follow this link for information about how to save your puzzle layouts.



Creating your own puzzles
Selection of this menu item allows you to create your own puzzles.    Upon selection you will be presented
with a message box asking whether or not you want the game pieces reset to their default positions prior 
to entering the create a puzzle environment.    Click the Yes button if you would like the pieces reset to 
their default positions and orientations.    However, if during the solving of a puzzle you've come up with 
an arrangement that you would like to make into your own puzzle, click the No button to keep the current 
layout intact.    If you no longer wish to start creating puzzles, then you should click the Cancel button.

Note that in the shareware version of OOG only puzzles created for the Tangrams polyform can actually 
be saved to disk.    To be able to create and save to disk puzzles for the other polyform puzzles you must 
register your copy of OOG.



Loading a puzzle from disk
Selection of this menu item allows you to load from disk a polyform puzzle previously created by OOG.    
You will be presented with the Load Puzzle Dialog Box.    This is just a standard File Open Dialog Box.    
The dialog box's File Name list box area will default to showing all files with the following file extensions 
depending on which polyform puzzle you are currently playing.

Polyform File Extension
Tangrams .TAN
Pentominoes .PNT
Hexagons .HEX
Polyominoes .PLY

Click here to learn how to create your own puzzles.

Command Buttons
Once you've selected the desired source directory and file name for the puzzle you wish to load, click the 
OK button to load that puzzle into OOG.    Click the Cancel button if you decide you no longer wish to 
load a puzzle from disk.    Clicking the Help button will display this help page.

Potential Pitfalls
This operation will reject any file it does not recognize as being an OOG puzzle file.    If you attempt to 
load "any old file" using this command, it will be rejected.    You can not load saved layout files using this 
operation.    These files will be rejected.    You can only load puzzle files created for the current polyform 
puzzle.    For instance if you try to load a Pentominoes puzzle while playing Tangrams, if will be rejected.    
First switch to Pentominoes and then load the puzzle using this operation.    If you are using the 
shareware version of OOG, you will only be able to load puzzles from disk for the Tangrams polyform.    
For more information, read about the benefits of registering.



Exiting OOG
Selection of this menu item exits OOG and returns you to the Windows operating system.



The Options Menu
The following commands are available from the Options menu.

Game Setup...                   Adjust application settings and features
New Player...                     Change players
Set Shape Color... Select the color of the game pieces
Set Puzzle Color... Select the color of the puzzle outline
Give Hint                           Cheat a little (you get to choose the piece)
Show Solution                   I give up, cheat big time



Setting up the game options
Selection of this menu item allows you to configure some of the operations performed by OOG.    After 
selecting this item, you will be presented with the Game Setup Dialog Box.    The interface components of 
this dialog box are discussed below.

Animation - Hints, Solution
Check this box if you would like OOG to animate the movement and rotation of the shapes whenever you 
ask for a hint or the solution to the current polyform puzzle.    If this box is unchecked, OOG simply places 
the shapes at their intended location.

Animation - Game Over Fanfare
Check this box if you would like OOG to perform its "game over" fanfare whenever you solve a puzzle.    If
this box is unchecked, you do not get any of the "game over" fanfare.    The fanfare consists of some 
simple graphics drawing and the playing of the "game over" WAV sound file.    The playing of the WAV 
sound file is also dependent upon the setting of the Enable All Sounds check box discusssed next.    As a 
result, it is possible to have the confetti thrown on the screen without having to listen to the WAV sound 
file.    (This is for those of you playing at work.)

Sound - Enable All Sounds
Check this box to enable the playing of all sounds within OOG.    If this box is unchecked, no sounds will 
be played.    Currently, the "game over" WAV file is the only available sound played by OOG.    (See the 
above discussion of the "game over" fanfare.)

Command Buttons
Select the OK button to accept your current settings in the dialog box.    If after entering this dialog box 
you change your mind and don't wish to make any changes or would like to restore your original settings, 
select the Cancel button.    Selection of the Help button displays this help page.



How to change players
Selection of this menu item brings up the New Player dialog box. The selections made in this dialog box 
control which player progress database the player progress tracking feature will be maintaining.

Visitor's Check Box
If this box is checked, the current player is identified as a "visitor" and the player progress database will 
only be maintained during the current gaming session.    Once the player quits OOG or switches to 
another polyform, the information currently stored in the database will be lost.

Enter/Select Your Name
This combo-box is used to restore/create a player progess database that will be maintained by OOG 
during subsequent gaming sessions.    If this is your first time playing and you would like to have your 
player progress database stored on disk for future sessions, enter your name into this control.    If you've 
played OOG before and already have a player progress database setup, find your name in the list box 
and select it.    OOG will then load your database from disk.

Restore Last Player at Startup
The New Player Dialog Box is automatically opened by OOG whenever the application is started.    This 
gives the user an opportunity to ensure that the correct player progress database is loaded.    If you check
this box, OOG will automatically restore the information for the last player without having to display this 
dialog box at startup.    If you would like to have the dialog box displayed whenever the applicatioin is 
started, make sure this box is unchecked.

Invalid New Player Message Box
If the Visitor's Check Box is unchecked and the Enter/Select Your Name control is empty and you then 
select the OK button, you will be presented with a message box informing you that you have not identified
a player.    Click the OK button on the message box and make another selection in the dialog box.



Changing the color of the game pieces
Selection of this menu item allows you to change the color of the game pieces, or shapes, of the current 
polyform puzzle.    You can select different color settings for each polyform found in OOG and they will be 
remembered for the next time you play.

After selecting this item, you will be presented with the Choose Color Common Dialog Box.    This is a 
standard, built-in Windows dialog box.    Select the rectangle displaying the color of your choice and click 
the OK button.    OOG will automatically update the associated screen object(s) with that color and 
memorize the selection for next time.    Remember, OOG memorizes the colors for each polyform 
separately.    So you can have different color selections for each polyform!

If you change your mind and don't wish to make a new color selection, just click the Cancel button and 
the original colors will be unaffected.

Selection of the Help button, displays this help page.



Changing the color of the puzzle
Selection of this menu item allows you to change the color of the puzzle outlines of the current polyform 
puzzle.    You can select different color settings for each polyform found in OOG and they will be 
remembered for the next time you play.

After selecting this item, you will be presented with the Choose Color Common Dialog Box.    This is a 
standard, built-in Windows dialog box.    Select the rectangle displaying the color of your choice and click 
the OK button.    OOG will automatically update the associated screen object(s) with that color and 
memorize the selection for next time.    Remember, OOG memorizes the colors for each polyform 
separately.    So you can have different color selections for each polyform!

If you change your mind and don't wish to make a new color selection, just click the Cancel button and 
the original colors will be unaffected.

Selection of the Help button, displays this help page.



Asking for a hint to a puzzle
Selection of this menu item allows you to receive a hint for the game piece of your choice.

You will be presented with a message box informing you to select the game piece for which you desire a 
hint.    If you decide you no longer want a hint, click the Cancel button.    Otherwise, click the OK button 
and then place the mouse cursor over the piece for which you want the hint and click the left mouse 
button.    (You can cancel your request for a hint, even after you select the OK button by pressing the Esc 
key.)    OOG will then position the shape you selected to the desired location either directly or using 
animation according to the settings in the Game Setup dialog box.

It should be noted that many polyform puzzles have more than one solution and even though OOG will 
detect your solution regardless of which one you find, all of the hints are based on a single solution built 
into OOG.    In other words, just because the hint mechanism places shape 'X' at location 'Y' that doesn't 
mean the puzzle can't be solved with shape 'X' in a totally different location.

If by some odd coincidence the intended position/orientation of the hint is identical to the current 
position/orientation of the selected game piece, a message box is displayed informing you of this 
condition.    (This is so you don't wonder why the selected piece was not moved anywhere.)

Follow this link for more information about solving polyform puzzles.



Asking for the solution to a puzzle
Selection of this menu item allows you to "give up" and see the solution for the current polyform puzzle.    
To guard against an accidental selection of this menu item, you will be presented with a message box 
verifying that you really want to see the solution.    If you don't wish to see the solution to the puzzle, click 
the No button.    Otherwise click the Yes button.

OOG will then proceed to position each shape in the polyform to its solution location either directly or 
using animation according to the settings in the Game Setup dialog box.

It should be noted that many polyform puzzles have more than one solution and even though OOG will 
detect your solution regardless of which one you find, it will always show the same solution for a given 
polyform puzzle when using this option because only one solution has been "built in" to satisfy this feature
and to give out hints (see below).

Follow this link if you just need a little hint.

Follow this link for more information about solving polyform puzzles.



The Switch Menu
The following commands are available from the Switch menu.

Tangrams                          Switch to the Tangrams polyform
Pentominoes                     Switch to the Pentominoes polyform
Hexagons                          Switch to the Hexagons polyform
Polyominoes Switch to the Polyominoes polyform



Switching to Tangrams
Selection of this menu item lets you play puzzles from the Tangrams polyform.



Switching to Pentominoes
Selection of this menu item lets you play puzzles from the Pentominoes polyform.



Switching to Hexagons
Selection of this menu item lets you play puzzles from the Hexagons polyform.



Switching to Polyominoes
Selection of this menu item lets you play puzzles from the Polyominoes polyform.

Note that this polyform puzzle is only available to registered users of OOG.



The Help Menu
The following commands are available from the Help menu.

Index                                               Displays the Index of this help file
Commands                        Displays the Commands section of this help file
How to Play                       Displays the How to Play section of this help file
Using Help                         Displays information about how to use help
What is Shareware...         Simple description of the concept of shareware
Why Register...                  Describe reasons and incentives for registering
How to Register...              Instructions for how to register
Register OOG... Registration dialog box
About...                                            Standard About Box



Displaying the help index
Selection of this menu item displays the table of contents for the OOG Help System.



Displaying help on the menu commands
Selection of this menu item displays a help page that provides access to descriptions of all the menu 
commands available while playing OOG.



Displaying help on how to play OOG
Selection of this menu item displays a help page describing how to play OOG.



Displaying help on using the help system
Selection of this menu item displays a help page describing how to use the Microsoft Windows WinHelp 
application. This is how you can get help on help.



Learning about the concept of shareware
Selection of this menu item displays a help page describing the concept of shareware.



Learning about why you should register
Selection of this menu item displays a help page describing the benefits you receive by registering OOG 
with MCM Productions.



Learning about how to register
Selection of this menu item displays a help page describing how to register OOG with MCM Productions.



Upgrading OOG from Shareware to Registered
Selection of this menu item allows you to upgrade your copy of OOG from the shareware version to the 
registered version.    As part of this process, you will be required to specify the user name and serial 
number sent to you by MCM Productions after we've processed your registration.    After selecting this 
item, you will be presented with the OOG Registration Dialog Box.    The interface components of this 
dialog box are discussed below.

User Name
Enter the user name you received in response to your registration.

Serial Number
Enter the serial number you received in response to your registration.

Command Buttons
Once you are satisfied the user name and serial number you have entered are correct, click the Register 
button.    After the information has been validated, you will be presented with a message box 
congratulating you on the successful registration of OOG.    (Your user name will now be displayed in the 
"Registered to:" section of the OOG About Box.)    If the entered data can not be successfully validated, 
you will be asked to recheck the data and try entering it again.    Click the Cancel button if you wish to 
leave this dialog box without entering your registration data.

Follow this link to learn how to register OOG.

Follow this link to learn about the benefits of registering OOG.



Displaying the OOG About Box
Selection of this menu item displays the OOG About Box.    The "Registered to:" text of the About Box will 
change from "Shareware Version" to your user name after you have registered your copy of OOG and 
entered your registration information in the OOG Registration Dialog Box.

Follow this link for information about how to register OOG.

Follow this link for information about MCM Productions.



How to create your own puzzles
So you want to know how to create your own polyform puzzles.    Well, you've come to the right page.    
Using this feature you can create a seemingly endless number of puzzles that you can then exchange 
with others by simply giving them a copy of your puzzle files.    (Don't forget to ask for a copy of their 
puzzle files in return.)    The format of these puzzles files is identical to the puzzle data stored inside of 
OOG.    The only difference is that they are loaded from disk.    This means that anything you can do with a
built-in puzzle, you can do with a user created puzzle!    For example, after loading a created puzzle from 
disk you can still:

· ask for a hint if the puzzle is really giving you a hard time
· ask for the solution if you've totally given up
· save your layout so you can try again later

How can I access this great feature!?
Simply select the Create Puzzle... item from the Puzzle Menu.

Now what do I do?
You design your puzzle by moving, rotating and flipping the given set of shapes that are available for the 
current polyform.    You do this using the exact same shape maneuver operations you use when trying to 
solve the puzzles.    Create your puzzles anywhere on the window you desire.    OOG will automatically 
center your puzzle about the window prior to saving it to disk.

Things to Remember
1) Polyform puzzles are not allowed to contain any overlapping shapes.    OOG verifies your puzzle meets
this condition before it allows the puzzle to be saved to disk.    This means that the edges and corners of a
shape are allowed to "touch" the edges or corner of another shape, but they are not allowed to cross into 
or over those of another shape.    You can use the save and restore layout commands if you wish to save 
the arrangement of your game pieces to disk before they are ready to be saved as a puzzle.

2) Each puzzle you create will always contain all the shapes in the current polyform.    For example, 
suppose you're creating a puzzle for the Pentominoes polyform and the resultant design uses only 10 of 
the 12 shapes.    The other 2 shapes must be a part of the puzzle.    We suggest you take the 2 unused 
shapes and artistically place them about your puzzle design as "free floating freebies" for the puzzle 
solver.

Once you're happy with your puzzle design, you can save it to disk.    Give a copy of the puzzle file to your
friends and they can load it from disk and give it a try.

Create Menu Commands
What menu commands are available while creating a puzzle?    Follow the link.

Some Fine Print
So as not to appear to mislead anyone, we must inform you that the operation of this feature differs 
between the shareware and registered versions of OOG.    Regardless of which version you are using, 
you will "always" be able to design puzzles for any of the polyforms found in OOG.    However, the 
shareware version will only allow you to actually save the created puzzles to disk for the Tangrams 
polyform.    You will not be able to save the puzzles you create to disk for any of the other polyforms found
in the shareware version.

Click here if you are interested in learning how to register OOG so you can create puzzles and save them 
to disk for the other polyform puzzles.



The Create Menu Commands
The following menus are available when you are creating a puzzle.

The Create Menu Save/restore your progress, save your puzzle creation...
The Help Menu                  Complete access to the application help system

The majority of the items available on the Create Menu are also available through the use of the OOG 
Quick-Click Menu.    This menu is simply a popup, shortcut menu that is displayed whenever you click and
hold down the right mouse button over the main window background when you are creating a puzzle.    
This shortcut menu also contains items that allow you to configure the way in which the game pieces 
snap together after a shape maneuver operation.

Following this link to see the menu commands available while playing OOG.



The Create Menu
The following commands are available from the Create menu while creating a puzzle.

Reset Shapes Reset the game pieces back to their default positions
Save Layout... Save the current layout of your game pieces
Restore Layout... Restore a previously saved layout of your game pieces
Save Puzzle... Validate and save your created puzzle to disk
Cancel Create Stop creating without saving your work



Resetting the game pieces
Selection of this menu item resets each of the game pieces back to their default position.    This menu 
item is also available via the 'F3' function key.



Saving the puzzles you create
Selection of this menu item allows you to save the puzzle you've created to disk.    Each puzzle that you 
create and save to disk is stored in a separate file with the name of your choosing.    These files can be 
exchanged with other users of OOG and then loaded into the program for even more game play.    After 
you select this menu item, the following steps are performed in the order listed.

Step 1 - Puzzle Validation
OOG verifies the validity of your puzzle by ensuring that none of the game pieces overlap.    Remember, 
this is a general rule for all polyform puzzles.    If overlapping pieces are detected, you will be presented 
with a message box asking that you remove the overlap and try saving again.    If OOG is able to 
successfully validate your puzzle, you move on to the next step.    You can use the save and restore 
layout commands if you wish to save the arrangement of your game pieces to disk before they are ready 
to be saved as a puzzle.

Step 2 - Name Your Puzzle
This step gives you the ability to customize your puzzle by giving it a name or description.    Note that this 
is not the name of the file used to store your created puzzle to disk.    This name will appear in the text 
window directly above the main play area on the OOG window.    You can name the puzzle anything you 
like.    We suggest something that you think describes what the puzzle looks or maybe you could use your
own name followed by a number you assign to the puzzle.    (You're going to create more than one puzzle,
aren't you?)    In the displayed dialog box, simply type the name or description you've decided on for the 
puzzle and click the OK button to proceed to the next step.    If you click the Cancel button in this dialog 
box, you will abort the entire save process and your puzzle will not be saved to disk.

Step 3 - Save Your Puzzle to Disk
Finally, you will be presented with the Save Puzzle Dialog Box.    This is just a standard File Save Dialog 
Box.    The dialog box's File Name edit control will contain the following suggested file name: 
"PUZZLE.XXX".

The file extension, shown as XXX above, will vary depending on which type of polyform puzzle you are 
currently creating.    The table below details the possible values for the file extension.    We suggest you 
change the file name to something a little more descriptive.

Polyform File Extension
Tangrams .TAN
Pentominoes .PNT
Hexagons .HEX
Polyominoes .PLY

Once you've selected the desired destination directory and file name for saving your puzzle, click the OK 
button to write the data to disk.    (If you are using the shareware version of OOG, you will only be able 
save the puzzles you create for the Tangrams polyform.    For more information, read about the benefits of
registering.)    Click the Cancel button if you decide you no longer wish to save your puzzle.    Clicking the 
Help button will display this help page.

That's It!
Your puzzle is now stored on disk and can be played by loading it into OOG.    At this point, OOG will ask 
if you wish to create another puzzle.    Answer appropriately and you're on your way.



When you want to stop creating puzzles
Selection of this menu item allows you to stop creating a puzzle without having to save your work.    Upon 
selection, you will be presented with a message box to verify your desire to stop creating puzzles.    Click 
the Yes button if you wish to stop creating and don't want to save your work.    If you've changed your 
mind and want to continue creating a puzzle, click the No button.



The Create Help Menu
The following commands are available from the Help menu while creating a puzzle.

Index                                               Displays the Index of this help file
Commands                        Displays the Create Commands section of this help file
How to Create                   Displays the How to Create section of this help file
Using Help                         Displays information about how to use help
About...                                            Standard About Box



Displaying the help index
Selection of this menu item displays the table of contents for the OOG Help System.



Displaying help for the create menu commands
Selection of this menu item displays a help page that provides access to descriptions of all the menu 
commands available while creating a puzzle with OOG.



Displaying help on how to create a puzzle
Selection of this menu item displays a help page describing how to create your own puzzles.



Displaying help on using the help system
Selection of this menu item displays a help page describing how to use the Microsoft Windows WinHelp 
application.    This is how you can get help on help.



Displaying the OOG About Box
Selection of this menu item displays the OOG About Box..    The "Registered to:" text of the About Box will
change from "Shareware Version" to your user name after you have registered your copy of OOG and 
entered your registration information in the Registration Dialog Box.

Follow this link for information about how to register OOG.

Follow this link for more information about MCM Productions.



The Shareware Concept
What is shareware?
When most people hear the word shareware they usually associate it with a particular software 
application.    However, the term shareware is not describing the program itself but the manner in which 
the program is being marketed.    Shareware is a marketing concept that allows you, the potential buyer, 
to evaluate a piece of software before you are required to pay for it.    A shareware author,    the seller, 
trusts you to pay for, or register, the program if you continue to use it beyond the stipulated evaluation 
period.

Our Terms & Conditions
OOG is a shareware program.    It is a complete, fully functional application.    You will be able to fully 
evaluate every feature available in OOG using the shareware version.    We allow you 30 days to evaluate
the program and if you find it useful and continue to use it beyond the 30 days, you are legally bound to 
register and pay for your copy.

MCM Productions encourages you to copy the shareware version of OOG and give it to all your friends 
and upload it to as many bulletin boards and online services as you see fit.

Follow this link to learn about the benefits you receive for registering OOG.

Follow this link to learn how to register OOG.



The Benefits of Registering
"OOG is a shareware program.    It is a complete, fully functional application.    You will be able to fully 
evaluate every feature available in OOG using the shareware version.    We allow you 30 days to evaluate
the program and if you find it useful and continue to use it beyond the 30 days, you are legally bound to 
register and pay for your copy."

The purpose of this help page is to discuss the benefits you receive after registering OOG.    A majority of 
companies producing shareware games provide the first episode of the game to the public in the form of 
shareware.    Upon registration of the shareware episode, they send you follow-up episodes as a bonus.    
These follow-up episodes are your benefits for registering.    We have taken a similar approach with OOG.

OOG is actually several games in one.    Each game allows you to play with and attempt to solve a 
different polyform puzzle.    Each polyform puzzle uses exactly the same interface and has exactly the 
same set of features as the others.    Once you know how to play one polyform puzzle, you know how to 
play all of them.    Any function you can do with one polyform puzzle, you can do with all of them.

OOG contains four different polyform puzzles or games.    The first polyform puzzle, the more popular 
Tangrams, is your primary evaluation polyform.    Using the Tangrams puzzles you will be able to fully and 
completely evaluate every single feature available within OOG.    (And remember, once you know how to 
use one polyform puzzle, you know how to use all of them.    The only differences between the polyform 
puzzles found in OOG are the shape and number of the pieces in the puzzle.)    The remaining polyform 
puzzles included in OOG are provided as incentives for registering.    In the shareware version, the 
number of puzzles included for these polyforms has been limited and the ability to load puzzles from disk 
and save created puzzles to disk has been turned off.    We have purposely done this to whet your 
appetite for more puzzles.    By registering your shareware version of OOG, you will have access to all the
puzzles included for these polyforms as well as the ability to load puzzles from disk and save created 
puzzles to disk.

The following list details the differences between the shareware and registered versions for each polyform
puzzle found in OOG.    If you have any questions regarding this or any other topic please contact MCM 
Productions.    Note that the Tangrams polyform is identical in both versions and that Polyominoes is only 
available to registered users.

Click here to learn how to register OOG

Polyform: Tangrams
# of Puzzles: 160 Shareware, 160 Registered
Load Puzzles from Disk: Yes Shareware, Yes Registered
Save Puzzles to Disk: Yes Shareware, Yes Registered

Polyform: Pentominoes
# of Puzzles: 10 Shareware, 52 Registered
Load Puzzles from Disk: No Shareware, Yes Registered
Save Puzzles to Disk: No Shareware, Yes Registered

Polyform: Hexagons
# of Puzzles: 10 Shareware, 34 Registered
Load Puzzles from Disk: No Shareware, Yes Registered
Save Puzzles to Disk: No Shareware, Yes Registered

Polyform: Polyominoes
# of Puzzles: N/A Shareware, 15 Registered
Load Puzzles from Disk: N/A Shareware, Yes Registered



Save Puzzles to Disk: N/A Shareware, Yes Registered



How to Register
You register your copy of OOG by sending MCM Productions the appropriate registration fee using one of
the methods discussed below.    Upon receipt of your registration, MCM Productions will send you your 
user name and serial number which when installed using the OOG Registration Dialog Box will give you 
full access to the registered version of OOG.

The cost of OOG is $20.00 US per copy. All future releases of OOG, to correct problems or to add or 
enhance features, are free after your one-time registration fee.    If you would like to install OOG on 
multiple computer systems at your site, please contact us for site license pricing information.    The more 
copies of OOG you purchase for your site, the better the price (perfect for educational institutions).

Registration Method #1
Fill out and send the registration form with a money order or a cheque drawn on a US bank to the address
listed on the form.    Users outside the United States please send an International Money Order or a 
cheque from any bank that has a corresponding bank in the US.    Your cheques should be made payable 
to "MCM Productions" in US funds only.    If you supply an e-mail address on the registration form, we will 
send you an e-mail message indicating that we have received and are processing your registration.    Your
user name and serial number will be mailed to you using the postal service within 48 hours.

· Sorry, at this time we don't accept credit cards or wire transfers.
· You assume all risk if you elect to send US cash through the mail.

Registration Method #2
If you have a CompuServe account, you can use CompuServe's shareware registration service to register
your copy of OOG.    Just "GO SWREG" and follow the prompts.    The registration ID # for OOG is 7639.   
CompuServe will bill the $20 US registration fee to your account.    This is the quickest way to register.    If 
you use this service, MCM Productions will send your user name and serial number to your CompuServe 
account via an e-mail message within 48 hours.

Follow this link for information about the concept of shareware.

Follow this link for information about the benefits of registering.



Registration Form
(Print this form by selecting "Print Topic" from the "File" menu.)

OOG, The Object Orientation Game
Order Form

Version 1.0, 09/18/95

Company Name: ________________________________________________

Your Name: ________________________________________________

Street Address: ________________________________________________

City, State, Zip Code: ________________________________________________

Country: ________________________________________________

E-mail Address: ________________________________________________

Register OOG for each machine on which the program is to be used.    Enclose $20
(cheque or money order in US funds) for each copy.    If you are ordering more than
10 copies of OOG, please contact MCM Productions for pricing information.

Number of copies ________ x $20.00 = $_________ Total Cost

Send this form with your cheque or money order in US funds to:

MCM Productions
P.O. Box 30404
Alexandria, VA 22310

==============================================================

Optional information we'd really like to know!

Where did you get your copy of OOG ?    If CIS or AOL, what online area ?

______________________________________________________________________

How did you hear about OOG ?

______________________________________________________________________

What version of OOG do you have ?    Check the About Box via the OOG Help menu.

______________________________________________________________________



About MCM Productions

Contacting MCM Productions

Hello!    Thank you for taking the time to download and try OOG !    To answer your first question: MCM 
stands for Mr. Confetti Man™, the company mascot pictured above and on the OOG startup splash 
screen.

MCM Productions is dedicated to developing high-quality Windows applications.    OOG is our first publicly
released application and we hope you find it entertaining and easy-to-use.    Whether or not you decide to 
become a registered user of OOG, feel free to send us your comments and suggestions.    We are as 
open and responsive to corrective criticism as we are to compliments.    We'd love to hear from you!

If you are experiencing any problems of any kind with your version of OOG, please contact us using one 
of the addresses listed above and we will do our best to quickly solve your problem.

MCM Productions currently has the following products planned for future release.

OOG Add-On Puzzles
Attention Registered Users!    Send us the puzzles you create for Pentominoes, Polyominoes and 
Hexagons and we'll release, free of charge, add-on puzzles for all our registered users.

MOOG, More OOG
Another set of challenging polyform puzzles using the OOG Library.    Tell us which polyforms you'd like to 
see us implement!

OOGE, The OOG Editor
Create your own polyform game pieces and puzzles.    Imagine being able to combine squares, triangles 
and other simple shapes to form your own game pieces which can then be used to create puzzles using 
the OOG Library.



Contacting MCM Productions
E-mail Addresses:

CompuServe: 70742,2337
Internet: confetti@aries.ai.net

World Wide Web Site:

http://www.mcmprod.com/

FTP Site:

mcmprod.com:/pub/confetti

Postal Service:

MCM Productions
P.O. Box 30404
Alexandria, VA 22310



Known Bugs & Limitations
The following is a list of the known bugs and/or limitations in Version 1.0 of OOG.    If you are experiencing
any problems with OOG, check this list to see if the issue is discussed and if you can't seem to solve or 
understand the problem yourself, please contact MCM Productions.

Click here to see the revision history of OOG

Building Puzzle Outlines
Whenever OOG loads a new puzzle, either from internal puzzle data or from those created and stored on 
hard disk, an algorithm is invoked to find the outer edges of the puzzle outline.    This outline is what gets 
displayed over the background when you are solving puzzles.    This algorithm is know to have problems 
with certain puzzle layouts.    These problem layouts tend to be rather complex and usually contain lots of 
holes that are diagonally adjacent to each other.    If the problem does occur, you will get one of the 
following two results.

1) OOG will report that it could not build the outline for the puzzle and will end up displaying each piece of
the puzzle in its original form (thereby giving away the solution).    We felt this was much better than 
possibly crashing or hanging the application.

2) OOG will build the puzzle outline and when it gets displayed it will not look like the puzzle outline you 
expected.

We are working on a solution to this problem and felt it was not a serious enough problem to warrant our 
not releasing OOG to the public until it was fixed.    If this problem really bugs you, please let us know.

Solution Detection
The algorithm used by OOG to automatically detect when you've found a solution to a puzzle is, in our 
opinion, very well designed and trustworthy.    We don't expect OOG to incorrectly report a puzzle as 
being solved when in fact it is not.    However, if you encounter this situation we'd really like to know about 
it.    This is not a challenge for everyone to try and break the algorithm, nor is there a reward if you do, but 
if you could save your current puzzle layout and then contact MCM Productions, we'd really appreciate it.



Revision History
The following list details the revision history of OOG.    The release information shown below is listed in 
reverse chronological order and is in no way meant to be a comprehensive listing of all the changes that 
occur between releases of this product.    MCM Productions makes no claims to the accuracy or 
completeness of this revision history.

---------------------------------------------------------------
Version #: 1.0
Release Date: September 18, 1995
Major Changes, Fixes & Enhancements:
Initial public release.
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License Agreement
This program is copyrighted 1993-1995 by MCM Productions.    All rights reserved.    This program is 
licensed to you only upon the terms and conditions listed below.    IF YOU DO NOT ACCEPT SUCH 
TERMS AND CONDITIONS, YOU MUST ERASE ALL COPIES OF THIS PROGRAM AND ALL 
ASSOCIATED FILES FROM YOUR SYSTEM AND/OR OTHER STORAGE MEDIA.

You may use this program free for 30 days after your initial receipt of this program, after which time you 
are required to either purchase the registered version of this program or to erase this program and all 
associated files from your system and/or other storage media.    To purchase the registered version of the 
program, you should contact MCM Productions, at P.O. Box 30404, Alexandria, VA 22310.    In no event 
may you install this program for use on a network, use this program on more than one computer or 
terminal at the same time, modify, disassemble, decompile or otherwise reverse engineer this program, 
rent or lease this program, except that you may copy this program for backup purposes in anticipation that
the original copy may become corrupted.    In no event shall you remove or alter any copyright, trademark 
or other notice included with this program or the registered version of this program.

Users are encouraged to give copies of this shareware program only to their friends as long as no 
program or associated files are modified in any manner.

Shareware vendors should refer to the VENDOR.DOC file for distribution information.

Contacting MCM Productions

Purchasing the registered version of this program



Warranty Disclaimer
MCM PRODUCTIONS DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER MCM PRODUCTIONS NOR 
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF MCM 
PRODUCTIONS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN 
NO EVENT SHALL MCM PRODUCTIONS' LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE
PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM.    THE 
PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF 
THE SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OF THE LIMIT OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO 
YOU.

THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF VIRGINIA AND SHALL 
INURE TO THE BENEFIT OF MCM PRODUCTIONS AND ANY SUCCESSORS, ADMINISTRATORS, 
HEIRS, AND ASSIGNS.    ANY ACTION OR PROCEEDING BROUGHT BY EITHER PARTY AGAINST 
THE OTHER ARISING OUT OF OR RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A
STATE OR FEDERAL COURT OF COMPETENT JURISDICTION LOCATED IN FAIRFAX COUNTY, 
VIRGINIA.    THE PARTIES HEREBY CONSENT TO IN PERSONAM JURISDICTION OF SAID COURTS.



Trademarks
Mr. Confetti Man, the MCM logo and likenesses are all trademarks of MCM Productions.    All companies, 
product names and services identified in this help file and elsewhere are trademarks, service marks, or 
registered trademarks of their respective companies.



Operation Not Available
This dialog box is presented whenever you attempt to perform an action that is not available in the 
shareware version of OOG.    The title of the displayed message box indicates the operation that failed to 
be performed.    Inorder to use these functions, you must register your shareware version of OOG with 
MCM Productions.

Follow this link for information about shareware.

Follow this link for information about the benefits of registering.

Follow this link for information about how to register.



Error Messages

Warning!!!
The displaying of any message box that causes you to reach this page, after pressing the 'F1' key, 
indicates that your version of OOG is most likely corrupt.    These message boxes indicate that OOG has 
detected a fatal error with its internal data.    These errors should not occur under normal circumstances.

If you receive one of these message boxes, we strongly suggest you contact MCM Productions to obtain 
the latest version of OOG.



This window allows you to see the definitions of various terms used throughout the OOG help system.    
For more detailed information on an item, refer back to the help system.

game pieces
layout file
player progress tracking
polyform puzzle
puzzle outline
puzzle file
quick-click menu
registration
shapes
shape maneuver operations
shareware
snapping
title window



The game pieces, or shapes, are the items you must move, rotate, and flip to completely overlay the 
displayed puzzle outline, without having any overlap among the pieces, in order to solve the polyform 
puzzle.    Sorry, but we have a bad habit of using the terms game pieces and shapes interchangeably.



A layout file describes the position and orientation of all the game pieces for a given polyform.    A layout 
file is used to save your progress on a puzzle so you can restore it at a later time and give the puzzle 
another try.    It can also be used to save a solution's layout after you've solved a puzzle and for saving a 
puzzle you are creating.



The player progress tracking feature gives OOG the ability to remember which puzzles a player has 
solved for a particular polyform.    Whenever you play, a database is being maintained that stores which 
puzzles have been solved for the current polyform.    When you solve a puzzle, the database is updated to
identify that that particular puzzle has been solved.



The goal of a polyform puzzle is rather simple to understand.    Your goal is to arrange a given set of 
shapes, or game pieces, to completely overlay, or cover, a given puzzle outline.    The resulting solution 
must not and will not contain any overlap amongst the shapes.    Note that many polyform puzzles have 
more than one solution.



The puzzle outline is the pattern(s) you are trying to duplicate with the given set of game pieces.    It is the 
colored item(s) in the OOG window that you can't manipulate with the mouse.    When you've duplicated 
the displayed pattern(s) using the given shapes, you've solved the puzzle!



A puzzle file describes a puzzle outline and contains the necessary information for OOG to give hints for 
and show the solution to the puzzle stored in that file.    A puzzle file is created whenever you create your 
own puzzles with OOG and save them to disk.    These files can then be loaded into OOG and played like 
the built-in puzzles.



This menu is simply a popup shortcut menu that is displayed whenever you click and hold down the right 
mouse button over the main window background when you are creating a puzzle.



Registration is the process by which you purchase OOG.    After your registration is processed, you will be
sent a user name and serial number that when entered into the OOG Registration dialog box will give you
complete access to the registered version of OOG.



The shapes, or game pieces, are the items you must move, rotate, and flip to completely overlay the 
displayed puzzle outline, without having any overlap among the shapes, in order to solve the polyform 
puzzle.    Sorry, but we have a habit of using the terms shapes and game pieces interchangeably.



These are the operations you must perform on the game pieces using the mouse in order to solve the 
polyform puzzle.    They are moving, rotating and flipping.    See the How to Play section of the help file for 
more information.



Shareware is a marketing concept that allows you, the potential buyer, to evaluate a piece of software 
before you are required to pay for it.    A shareware author,    the seller, trusts you to pay for, or register, the
program if you continue to use it beyond the stipulated evaluation period.

OOG is a shareware program.    It is a complete, fully functional application.    You will be able to fully 
evaluate every feature available in OOG using the shareware version.    We allow you 30 days to evaluate
the program and if you find it useful and continue to use it beyond the 30 days, you are legally bound to 
register and pay for your copy.



Snapping is the catch-phrase used to describe the operation performed by the auto-shape alignment 
algorithm in OOG.    The snapping algorithm is invoked at the conclusion of every shape maneuver 
operation (i.e. move, rotate or flip) and determines the intended location of the shape relative to any of its 
neighboring shapes or the puzzle outline.    Once the algorithm has determined the intended location of 
the shape, it snaps the shape to that location thereby freeing the game player from having to worry about 
perfectly aligning the pieces along side each other.



The title window is the rectangular area directly below the menu bar that displays a block of text with the 
following format: "### - TTTTT - X", where '###' is the internal number assigned to the puzzle, 'TTTTT' is 
the assigned title or description for the puzzle and 'X' indicates whether or not the puzzle has been solved
as indicated by the player progress tracking database.    (The 'X' is replaced by a 'U' for unsolved puzzles 
and an 'S' for solved ones.)    This window is also used for displaying various informative messages from 
OOG.






